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Chapter 1 Frontline Hardware & Software

Frontline Test Equipment family of protocol analyzers work with the following technologies.
o Classic Bluetooth

o Bluetooth low energy (BPA LE supports Bluetooth low energy features through Bluetooth 4.2, except
optional extended packet length.)

« Dual Mode Bluetooth (simultaneous Classic and low energy)
o Bluetooth Coexistence: Bluetooth with 802.11 Wi-Fi

o Bluetooth HCI (USB, SD, High Speed UART)

e NFC

o 802.11 (Wi-Fi)

« SD

e HSU (High Speed UART)

The Frontline hardware interfaces with your computer that is running our robust software engine called the
ComProbe Protocol Analysis System or Frontline software. Whether you are sniffing the air or connecting
directly to the chip Frontline analyzers use the same powerful Frontline software to help you test,
troubleshoot, and debug communications faster.

Frontline software is an easy to use and powerful protocol analysis platform. Simply use the appropriate
Frontline hardware or write your own proprietary code to pump communication streams directly into the
Frontline software where they are decoded, decrypted, and analyzed. Within the Frontline software you see
packets, frames, events, coexistence, binary, hex, radix, statistics, errors, and much more.

This manual is a user guide that takes you from connecting and setting up the hardware through all of the
Frontline software functions for your Frontline hardware. Should you have any questions contact the
Frontline Technical Support Team.

Frontline BPA low energy Hardware & Software User Manual 1



TELEDYNE LECROY Chapter 1 Frontline Hardware & Software

1.1 What is in this manual

The Frontline User Manual comprises the following seven chapters. The chapters are organized in the
sequence you would normally follow to capture and analyze data: set up, configure, capture, analyze, save.
You can read them from beginning to end to gain a complete understanding of how to use the Frontline
hardware and software or you can skip around if you only need a refresher on a particular topic. Use the
Contents, Index, and Glossary to find the location of particular topics.

« Chapter 1 Frontline Hardware and Software. This chapter will describe the minimum computer
requirements and how to install the software.

o Chapter 2 Getting Started. Here we describe how to set up and connect the hardware, and how to apply
power. This chapter also describes how to start the Frontline software in Data Capture Methods. You will
be introduced to the Control window that is the primary operating dialog in the Frontline software.

« Chapter 3 Configuration Settings. The software and hardware is configured to capture data. Configuration
settings may vary for a particular Frontline analyzer depending on the technology and network being
sniffed. There are topics on configuring protocol decoders used to disassemble packets into frames and
events.

« Chapter 4 Capturing and Analyzing Data. This Chapter describes how to start a capture session and how
to observe the captured packets, frames, layers and events.

« Chapter 5 Navigating and Searching the Data. Here you will find how to move through the data and how
to isolate the data to specific events, often used for troubleshooting device design problems.

« Chapter 6 Saving and Importing Data. When a live capture is completed you may want to save the
captured data for future analysis, or you may want to import a captured data set from another developer
or for use in interoperability testing. This chapter will explain how to do this for various data file formats.

« Chapter 7 General Information. This chapter provides advanced system set up and configuration
information, timestamping information, and general reference information such as ASCII, baudot, and
EBCDIC codes. This chapter also provides information on how to contact Frontline's Technical Support
team should you need assistance.

1.2 Computer Minimum System Requirements
Frontline supports the following computer systems configurations:
o Operating System: Windows 7/8/10
o USB Port: USB 2.0 High-Speed or or later
The Frontline software must operate on a computer with the following minimum characteristics.
e Processor: Core i5 processor at 2.7 GHz
« RAM: 4 GB

o Free Hard Disk Space on C: drive: 20 GB

1.3 Software Installation

Download the installation software from FTE.com. Once downloaded, double-click the installer and follow the
directions.

Use this link: http://www.fte.com/bpale-soft.

2 Frontline BPA low energy Hardware & Software User Manual
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Chapter 2 Getting Started

In this chapter we introduce you to the Frontline hardware and show how to start the Frontline analyzer
software and explain the basic software controls and features for conducting the protocol analysis.

2.1 BPA low energy Hardware
1. Insertthe USB cable mini-connector into the USB port on the Frontline BPA low energy hardware.

2. Insertthe other end of the USB cable into the PC.

mini USB
port

Figure 2.1 - BPA low energy Hardware USB Port

2.2 Data Capture Methods

This section describes how to load TELEDYNE LECROY Frontline Protocol Analysis System software, and how
to select the data capture method for your specific application.

2.2.1 Opening Data Capture Method
On product installation, the installer creates a folder on the windows desktop labeled "Frontline <version #>".
1. Double-click the " Frontline <version #>" desktop folder

This opens a standard Windows file folder window.

Frontline BPA low energy Hardware & Software User Manual 3
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Chapter 2 Getting Started

?( 4. » Frontline ComProbe Protocol Analysis System 12.11.662.0 »

- Include in library « Share with « Burn Mew folder
-~

) * MName

rites

sktop ‘E‘ J Developrment Tools

whnloads o ; Documentation

cent Places . Maintenance Tools

ogle Drive @ Capture File Viewer

Iries
curments

My Dorcemerts

2. Double-click on Frontline ComProbe Protocol Analysis System and the system displays the Select

Eﬂ ComProbe 802,11 with Wireshark
@ Frontline ComProbe Protocol Analysis System

Selectto open
Capture Methods

Figure 2.2 - Desktop Folder Link

Data Capture Method... dialog.

Note: You can also access this dialog by selecting Start > All Programs > Frontline

(Version #) > Frontline ComProbe Protocol Analysis System

Select Data Capture Method....

=3 Blustoath A Sniffing

=53 Wirtual Sriffing

{:’ Bluetooth Classic/low energy [BPA 600)

Fequirez one ComProbe BPA B00 hardware.

low energy data.

Uszed for typical applications to capture combined Bluetooth Classic and

&3 IEEE11073+

£ CPAS Side

Connected Devices

-
( [ Run ] [ Cancel ] [ Help ] i Create Shortcut When Run

Figure 2.3 - Example: Select Data Capture Method..., BPA 600

Three buttons appear at the bottom of the dialog; Run, Cancel, and Help.
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Select Data Capture Method dialog buttons
Button Description

Becomes active when a capture method is selected. Starts the selected capture
method.

Run
Cancel Closes the dialog and exits the user back to the computer desktop.

Help Opens Frontline Help. Keyboard shortcut: F1.

3. Expand the folder and select the data capture method that matches your configuration.

4. Click on the Run button and the Frontline Control Window will open configured to the selected
capture method.

Note: If you don't need to identify a capture method, then click the Run button to start the
analyzer.

Creating a Shortcut

A checkbox labeled Create Shortcut When Run is located near the
Create Shortout When Run bottom of the dialog. This box is un-checked by default. Select this
checkbox, and the system creates a shortcut for the selected method, and
places itin the "Frontline ComProbe Protocol Analysis System <version#>"
desktop folder and in the start menu when you click the Run button. This function allows you the option to
create a shortcut icon that can be placed on the desktop. In the future, simply double-click the shortcut to
start the analyzer in the associated protocol.

Supporting Documentation

The Frontline <version #>directory contains supporting documentation for development (Automation,
DecoderScript™, application notes), user documentation (Quick Start Guides and the Frontline User Manual),
and maintenance tools.

2.2.2 Frontline® BPA low energy Data Capture Methods

The Frontline Protocol Analysis System has different data capture methods to accommodate various
applications.

Frontline BPA low energy Hardware & Software User Manual
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Select Data Capture Method.... =

=149 Blustocth low energy Srifling Requires ane ComProbe BPA low energy hardware o one ComPiobe
¢ A Bluetaoth low energy FBLEA hardware
5 iualSirifing Used for typical applications to capture Elugtooth low energy data.
-4 FT5 Side
A IEEET1073+

Connected Devices

[ Fun ][ Cancel ] [ Help ] [7] Create Shortcut when Fun

Figure 2.4 - BPA low energy Select Data Capture Method
e Bluetooth low energy
o This method requires one Frontline BPA low energy hardware or one Frontline FBLEA hardware.

o Used for typical applications to capture Bluetooth low energy data.

2.3 Control Window

The analyzer displays information in multiple windows, with each window presenting a different type of
information. The Control window opens when the Run button is clicked in the Select Data Capture
Method window. The Control window provides access to each Frontline analyzer functions and settings as
well as a brief overview of the data in the capture file. Each icon on the toolbar represents a different data
analysis function.

% ComProbe Protocol Analysis System - Bluetooth low energy EI = @
File View Live Options Window Help

FHhed¥ LPRH B LW

Configuration: <MNo Device >
Capture file: C:\Users\Public\Documents\Frontine Test EquipmentiMy Capture Files\Capture-2013-05-23_074201.cfa
Capture Status: Paused (Capture to Single File) <1% used Packets on hfw: 0

For Help Press F1 Packet Decoder (0 pps) #0 - 100%

Figure 2.5 - Control Window
Because the Control window can get lost behind other windows, every window has a Home icon @ that
brings the Control window back to the front. Just click on the Home icon to restore the Control window.

When running the Capture File Viewer, the Control window toolbar and menus contain only those
selections needed to open a capture file and display the About box. Once a capture file is opened, the
analyzer limits Control window functions to those that are useful for analyzing data contained in the current
file. Because you cannot capture data while using Capture File Viewer, data capture functions are
unavailable. For example, when viewing Ethernet data, the Signal Display is not available. The title bar of the
Control window displays the name of the currently open file. The status line (below the toolbar) shows the
configuration settings that were in use when the capture file was created.

6 Frontline BPA low energy Hardware & Software User Manual
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2.3.1 Control Window Toolbar

Toolbar icon displays vary according to operating mode and/or data displayed. Available icons appear in color,
while unavailable icons are not visible. Grayed-out icons are available for the Frontline hardware and software
configuration in use but are not active until certain operating conditions occur. All toolbar icons have
corresponding menu bar items or options.

Table 2.1 - Control Window Toolbar Icons
Icon Description

r_ﬂ Open File - Opens a capture file.

'{3}; I/0 Settings - Opens settings

Start Capture - Begins data capture to disk

Stop Capture - Available after data capture has started. Click to stop data capture. Data can
be reviewed and saved, but no new data can be captured.

gl = e

Save - Saves the capture file.

"
M

Clear - Clears or saves the capture file.

Event Display - (framed data only) Opens a Event Display, with the currently selected bytes
highlighted.

Frame Display - (framed data only) Opens a Frame Display, with the frame of the currently
selected bytes highlighted.

Notes - Opens the Notes dialog.

Cascade - Arranges windows in a cascaded display.

Low energy - Opens the low energy Timeline dialog.

MSC Chart - Opens the Message Sequence Chart

Bluetooth low energy Packet Error Rate Statistics - Opens the Packet Error Rate Statistics
window.

= EHElad B Y

2.3.2 Configuration Information on the Control Window

The Configuration bar (just below the toolbar) displays the hardware configuration and may include I/O
settings. It also provides such things as name of the network card, address information, ports in use, etc.

IC-:unFiguratiDn: Displays hardware configuration, network cards, address information, ports in use, etc. I

Frontline BPA low energy Hardware & Software User Manual 7



TELEDYNE LECROY Chapter 2 Getting Started

2.3.3 Status Information on the Control Window

The Status bar located just below the Configuration bar on the Control window provides a quick look at
current activity in the analyzer.

Capture Status: | @ Mok Active (Capture to Single File)  Mf&  used| Utilization: 0% Host | 0% Control | Events: 0

o Capture Status displays Not Active, Paused or Running and refers to the state of data capture.
o Not Active means that the analyzer is not currently capturing data.
o Paused means that data capture has been suspended.
o Running means that the analyzer is actively capturing data.

o % Used

The next item shows how much of the buffer or capture file has been filled. For example, if you are
capturing to disk and have specified a 200 Kb capture file, the bar graph tells you how much of the
capture file has been used. When the graph reaches 100%, capture either stops or the file begins to
overwrite the oldest data, depending on the choices you made in the System Settings.

« Utilization/Events

The second half of the status bar gives the current utilization and total number of events seen on the
network. This is the total number of events monitored, not the total number of events captured. The
analyzer is always monitoring the circuit, even when data is not actively being captured. These graphs
allow you to keep an eye on what is happening on the circuit, without requiring you to capture data.

2.3.4 Frame Information on the Control Window

Frame Decoder information is located just below the Status bar on the Control window. It displays two pieces
of information.

IFl:ur Help Press F1 Frame Decoder (233 fps)  BEalemeEih RS a]nks

« Frame Decoder (233 fps) displays the number of frames per second being decoded. You can toggle this
display on/off with Ctrl-D, but it is available only during a live capture.

o #132911 displays the total frames decoded.

o 100% displays the percentage of buffer space used.

2.3.5 Control Window Menus

The menus appearing on the Control window vary depending on whether the data is being captured live or
whether you are looking at a .cfa file. The following tables describe each menu.

Table 2.2 - Control Window File Menu Selections
Hot

Mode Selection Description
Key

Live Close Closes Live mode.

8 Frontline BPA low energy Hardware & Software User Manual
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Table 2.2 - Control Window File Menu Selections (continued)

Mode Selection Hot Description
Key
Capture | Go Live Returns to Live mode
File
Reframe If you need to change the protocol stack used to interpret a
capture file and the framing is different in the new stack, you
need to reframe in order for the protocol decode to be correct.
See Reframing on page 36
Unframe Removes start-of-frame and end-of-frame markers from your
data. SeeUnframing on page 36
Recreate This option is available when you are working with decoders. If
Companion File you change a decoder while working with data, you can
recreate the ".frm file", the companion file to the ".cfafile".
Recreating the ".frm file" helps ensure that the decoders will
work properly.
Reload Decoders The plug-ins are reset and received frames are decoded again.
Live & Open Capture File | Ctrl- | Opens a Windows Open file dialog. at the default location
Capture -O | "...\Public Documents\Frontline Test Equipment\My Capture
File Files\". Capture files have a .cfa extension.
Save Ctrl- [ Saves the current capture or capture file. Opens a Windows
S Save As dialog at the default location "...\Public
Documents\Frontline Test Equipment\My Capture Files\".
Exit ComProbe Shuts down the ComProbe Protocol Analysis System and all
Protocol Analysis open system windows.
System
Recent capture files A list of recently opened capture files will appear.

The View menu selections will vary depending on the Frontline analyzer in use.

Table 2.3 - Control Window View Menu Selections

Mode Selection Hot key Description
Live & | Event Display Ctrl- Opens the Event Display window for analyzing byte level
Capture Shift-E | data.
File
Frame Display Ctrl- Opens the Frame Display window for analyzing protocol
Shift-M | level data

Bluetooth low
energy Timeline

Opens the Bluetooth low energy Timeline window for
analyzing protocol level data in a packet chronological
format and in packet throughput graph.

Bluetooth low

energy Packet Error

Rate Statistics

Opens the Bluetooth low energy PER Stats window to
show a dynamic graphical representation of the error rate
for each low energy channel.

Frontline BPA low energy Hardware & Software User Manual
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Table 2.4 - Control Window Edit Menu Selections

Mode Selection nfEs Description
key
Capture | Notes Ctrl- Opens the Notes window that allows the user to add
File Shift- | comments to a capture file.
@]

The Live menu selections will vary depending on the Frontline analyzer in use.

Table 2.5 - Control Window Live Menu Selections

Mode Selection Hoks Description
Key

The following two rows apply to all Frontline products except Set in Target.

Live Start Capture Shift- [ Begins data capture from the configured wireless devices.
F5
Stop Capture F10 Stops data capture from the configured wireless devices.

The following rows apply to all Frontline products

Live Clear Shift- | Clears or saves the capture file.
F10

10 Frontline BPA low energy Hardware & Software User Manual
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Table 2.5 - Control Window Live Menu Selections (continued)

Mode Selection Mo Description
Key

Live & | Hardware Settings 0 - Classic
Capture ’ hl
File 1 - Bluetooth low energy

1/0 Settings 0 - Classic

1 - Bluetooth low energy
System Settings Alt- Opens the System Settings dialog for configuring capture
Enter | files.

Directories...

Opens the File Locations dialog where the user can change
the default file locations.

Check for New
Releases at Startup

When this selection is enabled, the program automatically
checks for the latest Frontline protocol analyzer software
releases.

Side Names...

Opens the Side Names dialog used to customize the
names of the slave and master wireless devices.

Protocol Stack...

Opens the Select a Stack dialog where the user defines the
protocol stack they want the analyzer to use when
decoding frames.

Set Initial Decoder
Parameters...

Opens the Set Initial Decoder Parameters window. There
may be times when the context for decoding a frame is
missing. For example, if the analyzer captured a response
frame, but did not capture the command frame, then the
decode for the response may be incomplete. The Set Initial
Decoder Parameters dialog provides a means to supply the
context for any frame. The system allows the user to define
any number of parameters and save them in templates for
later use.Each entry in the window takes effect from the
beginning of the capture onward or until redefined in the Set
Subsequent Decoder Parameters dialog. This selection is
not present if no decoder is loaded that supports this
feature.

Set Subsequent
Decoder
Parameters...

Opens the Set Subsequent Decoder Parameters dialog
where the user can override an existing parameter at any
frame in the capture. Each entry takes effect from the
specified frame onward or until redefined in this dialog on a
later frame. This selection is not present if no decoder is
loaded that supports this feature.

Automatically
Request Missing
Decoder
Information

When checked, this selection opens a dialog that asking for
missing frame information. When unchecked, the analyzer
decodes each frame until it cannot go further and it stops
decoding. This selection is not present if no decoder is loaded
that supports this feature.

Enable/Disable
Audio Expert
System

When enabled, the Audio Expert System is active, other
wise it is not available. Only available when an Audio
Expert System licensed device is connected.

Frontline BPA low energy Hardware & Software User Manual
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The Windows menu selection applies only to the Control window and open analysis windows: Frame

Display, Event Display, Message Sequence Chart, Bluetooth Timeline, Bluetooth low energy
Timeline, and Coexistence View. All other windows, such as the datasource, are not affected by these
selections.

Table 2.6 - Control Window Windows Menu Selections

Mode Selection Al Description
Key
Live & | Cascade Ctrl-W [ Arranges open analysis windows in a cascaded view with
Capture window captions visible.
File
Close All Views Closes Open analysis windows.
Minimize Control When checked, minimizing the Control window also
Minimizes All minimizes all open analysis windows.
Frame Display and When these windows are open the menu will display these
Event Display selections. Clicking on the selection will bring that window
to the front.

Table 2.7 - Control Window Help Menu Selections

Mode Selection Hot-Key Description
Live & Help Topics Opens the Frontline Help window.
Capture . . . .
File About Frontline Provides a pop-up showing the version and release
Protocol Analysis information, Frontline contact information, and copyright
System information.
Support on the Web Opens a browser to fte.com technical support page.

2.3.6 Minimizing Windows

Windows can be minimized individually or as a group when the Control window is minimized. To minimize
windows as a group:

1. Go tothe Window menu on the Control @ window.

2. Select Minimize Control Minimizes All. The analyzer puts a check next to the menu item,
indicating that when the Control window is minimized, all windows are minimized.

3. Selectthe menu item again to deactivate this feature.

4. The windows minimize to the top of the operating system Task Bar.

12 Frontline BPA low energy Hardware & Software User Manual
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Chapter 3 Configuration Settings

In this section the Frontline software is used to configure an analyzer for capturing data .

3.1 BPAle I/O Settings - Datasource

3.1.1 BPA Low Energy datasource Toolbar/Menu

The datasource dialog toolbar and menu options are listed below.

Table 3.1 - BPA Low Energy Datasource Toolbar

Icon

Description

Start Sniffing button to begin sniffing. All settings are saved automatically when you
start sniffing.

Pause button to stop sniffing.

=

Save button to save the configuration if you made changes but did not begin sniffing. All
settings are saved automatically when you start sniffing.

o

Help button opens the help file.

Table 3.2 - BPA Low Energy datasource Menu

Menu Item Description

File

Save and Exit options, self explanatory.

View

Hides or displays the toolbar

BPA Low Energy | Start Sniffing, Stop Sniffing

Help

Opens ComProbe Help, and About BPA Low Energy.

Frontline BPA low energy Hardware & Software User Manual
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3.1.2 BPA low energy Devices Under Test

You can select the ComProbe BPA low energy analyzer for sniffing Bluetooth low energy communications on
available devices.

Note: Frontline BPA LE supports Bluetooth low energy features through Bluetooth 4.2,
except optional extended packet length.

€3 EPA Low Energy datasource I. = ih,l

File VWiew BPALow Energy Help
@Ol HY

Devices Under Test | LE Device Database | BPA low energy Information

LE Device: (ked0ff50839370) Tile -
LE Encryption

Long Temn Key: PINADOEB data:

[] Sriffer Diagnostics
[] Fitter out ADV packets for Non-corfigured devices

Clear

Figure 3.1 - BPA Low Energy datasource Devices Under Test Tab

The default value in the LE Device drop down is Sync with First Master. Devices in the LE Device
Database may be selected. Once a device is selected or if any other change is made to the Devices Under
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Test tab, the toolbar save button E becomes available. Clicking on this button will save the current Devices
Under Test settings that will be available the next time you open ComProbe BPA low energy analysis.

To begin sniffing Bluetooth low energy simply click the red Start button o on the datasource toolbar.

Specifying the LE Device Address

You may specify the LE device you are testing by typing in or choosing its address (BD_ADDR). You can type it
directly into the drop down, or choose it from the existing previous values list in the drop down.

Alternatively you can open the LE Device Database tab, right-click on any device in the list, and click on
Select LE Device in the pop-up menu. The selected device's BD_Addr and Nickname will appear in the
LE Device field.

To enter the device manually type the address - 12 digit hex number (6 octets). The "0x" is automatically

typed in the drop down control.

Note: If one device changes its address and the other device does not, then select the
device address that does not change for the LE Device Address field.

Once you have the devices address identified, the next step is to identify the Encryption.

LE Encryption

LE Encipption
Long Tem Key FINADOE data

Figure 3.2 - BPA low energy Devices Under Test LE Encryption
1. Enter the Long Term Key for the LE Encryption.

The Long Term Key is similar to the Link key in Classic. Itis a persistent key that is stored in both devices
and used to derive a fresh encryption key each time the devices go encrypted.

Click here to learn more about the Long Term Key.

In LE, the long term key is generated solely on the slave device and then, during pairing, is distributed to a
master device that wants to establish an encrypted connection to that slave in the future. Thus the long term
key is transmitted over the air, albeit encrypted with a one-time key derived during the pairing process and
discarded afterwards (the so called short term key).

The long term key is directional, i.e. it is only used to for connections from the master to the slave (referring
to the roles of the devices during the pairing process). If the devices also want to connect the other way
round in the future, the device in the master role (during the pairing process) also needs to send its own long
term key to the device in the slave role during the pairing process (also encrypted with the short term key of
course), so that the device which was in the slave during the pairing process can be a master in the future and
connect to the device which was master during the pairing process (but then would be in a slave role).

Since most simple LE devices are only ever slave and never master at all, the second long term key exchange
is optional during the pairing process.

Note: f you use Copy/Paste to insert the Long Term Key , ComProbe software will auto
correct (remove invalid white spaces) to correctly format the key

Frontline BPA low energy Hardware & Software User Manual 15
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2. Enter a PIN or out-of-band (OOB) value for pairing.
This optional information offers alternative pairing methods.

Click here to learn more about these possible pairing values.
One of two pieces of data allow alternative pairing:

1. PIN is a six-digit (or less if leading zeros are omitted) decimal number.

2. Out-of-Band (OOB) data is a 16-digit hexadecimal code which the devices exchange via a channel that is
different than the le transmission itself. This channel is called OOB.

For off-the-shelf devices we cannot sniff OOB data, but in the lab you may have access to the data exchanged
through this channel.

Click here to see how to capture data after completing the configuration.

Sniffer Diagnostics: Checking this box will record communications traffic between ComProbe software
and the ComProbe BPA low energy hardware. Most often used in conjunction with Frontline Technical
Support instructions should the user have problems with their hardware. Checking this box will not affect
capture, analysis, or display of data.

Filter out ADV packets for Non-Configured devices: Checking this box will filter out advertising packets
from devices not specified in the LE Device field. If "Sync with First Master" has been selected in the LE
Device field checking this box will have not affect. the purpose of this option is to reduce the advertising
traffic in situations where there are many devices; advertising traffic can clutter the captured data with
unnecessary packets.

3.1.3 BPA Low Energy LE Device Database

The LE Device Database contains information about low energy devices that have been discovered or
entered by the user.

&) BPA Low Energy datasource = =

File View BPALowEnergy Help
e HO

Devices Under Test | LE Device Database | BPA low energy Information |

BD Addr BD Addr Type Identity Resolving Key (IRK) Nickname
0xd0ff5083937 Public 0x00000000000000000000000000000000 Tile
Oxcedd 1770 1824 Public 0x00000000000000000000000000000000

0x472b6c789571 Public 0x00000000000000000000000000000000

Oxeal4fed798c3 Public 0x00000000000000000000000000000000 Device 1
0x000000000000 Public 0x00000000000000000000000000000000 <Added Device>

Figure 3.3 - BPA Low Energy datasource LE Device Database Tab

The LE Device Database is automatically updated when you perform certain operation such as entering
encryption information from the Devices Under Test dialog.

Device Control Menu

BD Addr BD Addr Type Identity Resolving Key (IRK)
Right-clicking anywhere in Oxd0ff5083937h Public Ox00000000000000000000000000000000
the device list will display the Dxcedo 17701824 m . I
device control menu that will Ox472h6c739571 Public Select LE Device
Select, Delete, or Add a Oxea 14fed 79603 Public Delete LE Device(s)
device.. Clicking on one of .
these menu items will Add LE Device
perform the following
actions.
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Table 3.3 - LE Device Database Control Menu

Menu

Item Action

Test.

Select | Will place this device into the LE Device field in the Device Under Test tab. The device must
be selected/highlighted in the list prior to making this menu selection. If multiple devices have
been selected/highlighted in the list, the first device in the list is placed in the Device Under

devices in the list will delete all of those devices.

Delete | Will deleted the selected/highlighted device from the database. Selecting/highlighting multiple

Add Used for manual entry of a device into the database. A new device entry will append to the

Addr Type field, double click and tab to select available types. See the following image.

end of the device list. To enter data double click on the field and type in the data. For the BD_

| Public 0x00000000000000000000000000000000 <Added Device> |
Figure 3.4 - Add Menu Option Fields Display
Editing a Device

Any device entry can be edited by double-clicking in the field. An edit box will open and new device
information can be typed in.

BD Addr BD Addr Type Identity Resolving Key (IREK) Mickname

T et PV . 00000000000000000000000002000000 Tie

Figure 3.5 - Editing IRK Field

When editing the BD_Addr Type field "<Tab to toggle>" appears. Press the keyboard Tab key until your
selected device address type appears.

LE Device Database Fields
In the LE Device Database table the following columns appear.

Table 3.4 - BPA Low Energy Datasource LE Device Database Fields

is a 48 bit randomly generated address. "Private" address is a 48 bit

is generated using an IRK.

Column Description
BD_Addr The address of the Bluetooth low energy device
BD_Addr Type May be either "Public" or "Random". "Public"addresses are set to BD _

Addr. "Random" is either a 'static" or "private" address. "Static" address

"non-resolvable" address or "resolvable' address. A "resolvable" address

(IRK) host device with alist of IRKs can search the list to identify a peer

used to identify Bluetooth low energy devices that have previously
authenticated.

Identity Resolving Key Will appear when BD_Addr Type is Random, Private, and Resolvable. A

device that has previously authenticated with the host. This field can be

Nickname A user-added name for the device, often used to make device
identification easier during the analysis. Can be any alpha-numeric
string.

Frontline BPA low energy Hardware & Software User Manual
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3.1.4 BPA low energy Datasource Information

The ComProbe BPA low energy Information tab is one of the three tabs that appear when you first start the
low energy analyzer.

%4 BPA Low Energy datasource . &

File View BPA LowEnergy Help
el HY

| Devices Under Test | LE Device Database | BPA low energy Information

FEA3D422 Refresh Device List

Update Fimware... ]

Firmware Version: BPA 600 268 (17-Apr-14) BERA 600 (k23)

Figure 3.6 - BPA low energy Information Tab
There are several pieces of information on this display:

« Displayed in the text window is the serial number of the connected BPA 600 device. To update the device
list click Refresh Device List.

« If you want to load the latest ComProbe BPAle hardware firmware, you select the Update Firmware
button..

o The current firmware is displayed under Firmware Version.
3.1.5 BPA low energy Update Firmware
When you select the Update Firmware on the BPA Low Energy datasource information tab, the

Update BPA low energy ComProbe firmware dialog appears. You use this dialog to update your low
energy analyzer with the latest firmware.

It is very important that you update the firmware. If the firmware versions are not the same, you will not be
able to start sniffing.
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e =~

Update BPA low energy ComProbe firmware

File: Z:\Program Files {x86)\Frontiine Test System IIFrontline ComProbe Protocol Analysis Syskerm 12

Skatus: Ertor opening DFL File

Flash Device Done | | Help

Figure 3.7 - BPA low energy Information Tab Update Firmware Dialog
1. Make sure the ComProbe BPA low energy analyzer is attached.
2. Select the location of the firmware file.

3. Select Flash Device. The download begins, with the Status bar displaying the progress. When the
download is complete, you can check the firmware version by checking the Status field.

4. Select Done when the update is finished.

3.2 Decoder Parameters

Some protocol decoders have user-defined parameters. These are protocols where some information cannot
be discovered by looking at the data and must be entered by the user in order for the decoder to correctly
decode the data. For example, such information might be a field where the length is either 3 or 4 bytes, and
which length is being used is a system option.

There may be times when the context for decoding a frame is missing. For example, if the analyzer captures a
response frame but does not capture the command frame, then the decode for the response may be
incomplete. The Set Initial Decoder Parameters window allows you to supply the context for any frame.
The dialog allows you to define any number of parameters and save them in a template for later use

The decoder template function provides the capacity to create multiple templates that contain different
parameters. This capability allows you to maintain individual templates for each Bluetooth® network
monitored. Applying a template containing only those parameters necessary to decode transmissions
particular to an individual network, enhances the efficiency of the analyzer to decode data.

If you have decoders loaded which require decoder parameters, a window with one tab for every decoder
that requires parameters appears the first time the decoder is loaded.

For help on setting the parameters, click the Help button on each tab to get help information specific to that
decoder.

If you need to change the parameters later,

o Choose Set Initial Decoder Parameters... from the Options menu on the Control and Frame
Display windows.
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Options | Window  Help

Hardware Settings 2
I/0 Settings b
Systern Settings... Alt+Enter
Directories...

v | Check for New Releases at Startup

| Side Mames...

Protocol Stack...
Set Initial Decoder Parameters...

Set Subsequent Decoder Parameters...

v Automatically Request Missing Deceding Infermation

Figure 3.8 - Select Set Initial Decoder Parameters... from Control window

The Set Initial Decoder Parameters window opens with a tab for each decoder that requires
parameters.

Set Initial Decoder Parameters

9= H

|AVDTF‘ | Security | L2CAP | RFCOMM | A20F | Use | iPx | TCP | uDP |

Temnplate

Figure 3.9 - Tabs for each decoder requiring parameters.

o Each entry in the Set Initial Decoder Parameters window takes effect from the beginning of the
capture onward or until redefined in the Set Subsequent Decoder Parameters dialog.

Override Existing Parameters

The Set Subsequent Decoder Parameters dialog allows the user to override an existing parameter at any
frame in the capture where the parameter is used.

If you have a parameter in effect and wish to change that parameter
o Select the frame where the change should take effect

o Select Set Subsequent Decoder Parameters... from the Options menu, and make the needed
changes. You can also right-click on the frame to select the same option.
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Options | Window Help

Directories...
v Check for New Releases at Startup

Side Mames...

Protocol Stack...
Set Initial Decoder Parameters...
i Set Subsequent Decoder Parameters...

v Automatically Request Missing Deceding Information

Figure 3.10 - Set Subsequent Decoder Parameters... from Control window

OrEa8QCGO D ™ | RRB R
Unfiltered | Info | Configured BT low energy devices | Enors |
Baseband | LMP | PreConnection-FHS | Bluetooth FHS | L2CAP | SDP W—
B.. Frameft Fole Addr. DLl Charnel  Frame Type P/AF Bt Cmd.. Cmd Type =
50 Master 1 0x00 a SABh 1
51 Slave 1 0x00 a A 1
52 I aster 1 000 0 UIH a Com... Param. Meg.
A3 Slave 1 0«00 1] UIH 0 FRes.. Param. Neg.I A

Set Subsequent Decoder Parameters

H52. RFCOMM

Rules in effect from frame #52 onward until redefined here for a later frame:

Onthe Slave side, with Server Channel 13, RFCOMM is camying Hands Free { Ovenidden by user )

Change the Selected temto Camy | Hands Free =
o]

Figure 3.11 - Example: Set Subsequent Decode for Frame #52, RFCOMM

« Each entry in the Set Subsequent Decoder Parameters dialog takes effect from the specified frame
onward or until redefined in this dialog on a later frame.

« The Remove Override button will remove the selected decode parameter override.
« The Remove All button will remove all decoder overrides.

If you do not have decoders loaded that require parameters, the menu item does not appear and you don't
need to worry about this feature.

3.2.1 Decoder Parameter Templates

3.2.1.1 Select and Apply a Decoder Template

1. Select Set Initial Decoder Parameters... from the Options menu on the Control @ window

or the Frame Display @ window.
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2.

Click the Open Template Fg icon in the toolbar and select the

_ ﬁ m x |Temp|ate F

desired template from the pop up list. The system displays the
content of the selected template in the Initial Connections list at F'_| Frontlinel ‘

the top of the dialog Frontline?
Click the OK button to apply the selected template and decoders' Frontline2 1 '
. . i, . al |
settings and exit the Set Initial Decoder Parameters dialog. - Frontline2 .
the
L"E Frontlings I

3.2.1.2 Adding a New or Saving an Existing Template

Add a Template

A template is a collection of parameters required to completely decode communications between multiple
devices. This procedure adds a template to the system and saves it for later use:

1.

Click the Save E button at the top of the Set Initial S ——
Decoder Parameters dialog to display the Template
Manager dlalog Mame Ta Save Template As: Cancel

Frantlined

Enter a name for the new template and click OK. Cuntertly Saved Templates For This Objast Tupe:

Frontling

The system saves the template and closes the Template FrontineZ
Manager dialog. i

Frontlined
Frontline5

Click the OK button on the Set Initial Decoder
Parameters window to apply the template and close the
dialog.

Save Changes to a Template

This procedure saves changes to parameters in an existing template.

1.

After making changes to parameter settings in a user defined template, click the Save E button at
the top of the Set Initial Decoder Parameters window to display the Template Manager dialog.

Ensure that the name of the template is listed in the Name to Save Template As text box and click
OK.

The system displays a dialog asking for confirmation of the change to the existing template. Click the
Yes button.

The system saves the parameter changes to the template and closes the Save As dialog.

Click the OK button on the Set Initial Decoder Parameters window to apply the template and
close the window.

3.2.1.3 Deleting a Template

22

1.

After opening the Set Initial Decoder Parameters window click the Delete { button in the

toolbar.

The system displays the Template Manager dialog with a list of saved templates.
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2. Select (click on and highlight) the template marked for deletion and click the Delete button.
The system removes the selected template from the list of saved templates.
3. Click the OK button to complete the deletion process and close the Delete dialog.

4. Click the OK button on the Set Initial Decoder Parameters window to apply the deletion and
close the dialog.

3.2.2 Selecting A2DP Decoder Parameters

Decoding SBC frames in the A2DP decoder can be slow if the analyzer decodes all the parts (the header, the
scale factor and the audio samples) of the frame. You can increase the decoding speed by decoding only the
header fields and disregarding other parts. You can select the detail-level of decoding using the Set Initial
Decoder Parameters window.

Note: By default the decoder decodes only the header fields of the frame.
1. Select Set Initial Decoder Parameters from the Options menu on the Control window or the
Frame Display window.
2. Click on the A2DP tab.

3. Choose the desired decoding method.

| AVDTP | Security | L2CAP | RFCOMM | A2DP |use |IPx | TCP | uDP |

SBC frames decoding Information
@) Decode only the header fields of the SBC frame in detail

Decode all the parts (the header, the scale factors and the audio samples ) of the
SBC frame in detail

Figure 3.12 - A2DP Decoder Settings
4. Follow steps to save the template changes or to save a new template.
5. Click the OK button to apply the selection and exit the Set Initial Decoder Parameters window.

3.2.3 L2CAP Decoder Parameters
3.2.3.1 About L2CAP Decoder Parameters

Each entry in the Set Initial Decoder Parameters dialog takes effect from the beginning of the capture onward
or until redefined in the Set Subsequent Decoder Parameters dialog.

AVDTP [ Securty | L2CAP [RFcOMM [A2DP [use [ipx  [TcP [upe |

Initial Connections i effect from beginning of capture orward urtil redefined in the Set Subsequent Decoder Parameters dialog)

Stream Master -
Charnel ID
Address

DataSource(DS) No. {set Ofor Single DS)

Caries (PSM) = Raw Data - -

Figure 3.13 - L2CAP Decoder parameters tab
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The L2CAP Set Initial Decoder Parameters dialog requires the following user inputs to complete a
Parameter :

« Stream - This identifies the role of the device initiating the frame (master or slave)
o Channel ID - The channel number 0 through 78

o Address - This is the physical connection values for the devices. Each link in the net will have an address.
A piconet can have up to seven links. The Frame Display can

provide address information. o Frame 37: [Slave] Len=27
+- Bazeband:

« Data Source (DS) No. -When only one data source is employed, - L2CAP:
set this parameter to O (zero), otherwise, set to the desired data P
source number.

Rale: Slave

Carries (PSM) - Select the protocol that L2CAP traverses to from the

. - Channel 1D: 020040 [SDP)
following:

- S0P

« AMP Manager
o AMP Test Manager
. SDP
« RFCOMM
« TCS
o LPMP
« BNEP
« HCRP Control
« HCRP Data
. HID
« AVCTP
o AVDTP
o« CMTP
« MCAP Control
« |EEE P11073 20601
« -Raw Data-
Adding, Deleting, and Saving L2CAP Parameters
1. From the Set Initial Decoder Parameters window, click on the L2ZCAP tab.
2. Setorselectthe LZCAP decoder parameters.

3. Click on the ADD button. The Initial Connection window displays the added parameters.
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Initial Cannections {in effect from beginning of capture onward until redefined in the Set Subsequent Decoder Parameters dialog):

On the Slave side, with CID GeD000, Address 0, and DataSource 1, L2CAF is camying AMP Test Manager
On the Master side, with CID (D000, Address 0, and DataSource 2, L2CAP is camying SMP
On the Master side, with CID (l0de, Address 0, L2CAF is camying — Raw Data -

Figure 3.14 - Parameters Added to Decoder

4. To delete a parameter from the Initial Connections window, select the parameter and click on the

Delete button.

5. Decoder parameters cannot be edited. The only way to change a parameter is to delete the original as

described above, and recreate the parameter with the changed settings and selections and then click

on the Add button.

6. L2CAP parameters are saved when the template is saved.

3.2.3.2 L2CAP Override Decode Information

The Set Subsequent Decoder Parameters dialog allows the user to override an existing parameter at any

frame in the capture where the parameter is used.

If you have a parameter in effect and wish to change that parameter:

1. Select the frame where the change should take effect

2. Select Set Subsequent Decoder Parameters from
the Options menu, or by selecting a frame in the frame
display and choosing from the right-click pop-up menu,
and make the needed changes. Refer to

3. Change the L2CAP parameter by selecting from the rule
to change, and click on the listed parameters.

4. If you wish to remove an overridden rule click on
Remove Override button. If you want to remove all
decoder parameter settings click on Remove All.

5. Click OK.

Each entry in the Set Subsequent Decoder Parameters
dialog takes effect from the specified frame onward or until
redefined in this dialog on a later frame.

Note: If the capture has no user defined overrides, then the
system displays a dialog stating that no user defined

overrides exist.

3.2.4 RFCOMM Decoder Parameters
3.2.4.1 About RFCOMM Decoder Parameters

Each entry in the Set Initial Decoder Parameters dialog takes effect from the beginning of the capture

A Slave B (L0001 (Sionalind]

This is the Summary Pane

Copy Selection to Clipboard
Save Selection...

Go To...

Show Frame Size Column
Show Timestamp Column
Show Delta Column

Add New Column (Help)
Remowve New Column
Change Column Order (Help)

Restore Default Columns

Add Bookmark...
Export...

Provide L2CAP Rules...
Provide RFCOMM Rules...

Set Subsequent Decoder Parameters...

Show Hidden Panes

onward or until redefined in the Set Subsequent Decoder Parameters dialog.

Frontline BPA low energy Hardware & Software User Manual
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| AvDTP | Secury | L2cap | RFCOMM |a2pP [usB [P [TcP | uoP |

Iniial Connections in effect from beginning of capture omward unti redsfined inthe Set Subsequent Decoder Parameters dialog):

Stream

Server Charnel 5

oLel 0

DataSource(DS) Ho. (set Ofor Single DS) 0

Carries (UUID) [oBex -

Figure 3.15 - RFCOMM parameters tab

The RFCOMM Set Initial Decoder Parameters tab requires the following user inputs to complete a
parameter:

« Stream - Identifies the role of the device initiating the frame (master or slave)
« Server Channel - The Bluetooth® channel number O through 78

o DLCI - This is the Data Link Connection Identifier, and identifies the ongoing connection between a client
and a server

« Data Source (DS) No.- When only one data source is employed, set this parameter to O (zero),
otherwise, set to the desired data source

« Carries (UUID) - Select from the list to apply the Universal Unique Identifier (UUID) of the application
layer that RFCOMM traverses to from the following:

o OBEX

o SPP

o encap asyncPPP

o Headset

o FAX

o Hands Free

o SIM Access

o VCP

o UDI

o -Raw Data-

Adding, Deleting, and Saving RFCOMM Parameters

1. From the Set Initial Decoder Parameters window, click on the RFCOMMtab.
2. Setor selectthe RFCOMMdecoder parameters.

3. Click on the ADD button. The Initial Connection window displays the added parameters.

Inital Connections (i effect from beginning of capture onward unti redefined)

piconet 2 on th Slave side with the L2CAP CID (0000 and with the remote sids TSID 0. the AVDTP is ca gnisling packets (Madfied by user
In the picenet 2 an the Master side with the L2CAP CID (+0000 and wih the remete side TSID -1, the AVDTP is camying Rparting packets (Modficd by user)
n the piconet 2 on the Master side with the L2CAP CID &x0000 and with the remote side TSID 0, the AVDTP is canying Unknown (Modfied by user)

Figure 3.16 - Parameters Added to Decoder
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4. To delete a parameter from the Initial Connections window, select the parameter and click on the
Delete button.

5. Decoder parameters cannot be edited. The only way to change a parameter is to delete the original as
described above, and recreate the parameter with the changed settings and selections and then click
on the Add button.

6. RFCOMM parameters are saved when the template is saved as described in on page 1

3.2.4.2 RFCOMM Missing Decode Information

ComProbe software usually determines the protocol carried in an RFCOMM payload by monitoring previous
traffic. However, when this fails to occur, the Missing Decoding Information Detected dialog appears
and requests that the user supply the missing information.

The following are the most common among the many possible reasons for a failure to determine the
traversal:

o The capture session started after transmission of the vital information
o The analyzer incorrectly received a frame with the traversal information

« The communication monitored takes place between two players with implicit information not included in
the transmission

In any case, either view the RFCOMM payload of this frame (and other frames with the same channel) as hex
data, or assist the analyzer by selecting a protocol using this dialog.

Note that you may use the rest of the analyzer without addressing this dialog. Additional information gathered
during the capture session may help you decide how to respond to the request for decoding information.

If you are not sure of the payload carried by the subject frame, look at the raw data shown under data in the
Decode pane in the Frame Display. You may notice something that hints as to the profile in use.

In addition, look at some of the frames following the one in question. The data may not be recognizable to the
analyzer at the current point due to connection setup, but might be discovered later on in the capture.

3.2.4.3 RFCOMM Override Decode Information

The Set Subsequent Decoder Parameters dialog allows the user to override an existing parameter at any
frame in the capture where the parameter is used.

If you have a parameter in effect and wish to change that parameter:
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Select the frame where the change should take effect,
and select Set Subsequent Decoder Parameters
from the Options menu, or by selecting a frame in the
frame display and choosing from the right-click pop-up
menu, and make the needed changes.

Change the RFCOMM parameter by selecting from the
Change the Selected Item to Carry drop down list.

If you wish to remove an overridden rule click on
Remove Override button. If you want to remove all
decoder parameter settings click on Remove All.

Choose the protocol the selected item carries from the
drop-down list, and click OK.

Each entry in the Set Subsequent Decoder Parameters
dialog takes effect from the specified frame onward or until
redefined in this dialog on a later frame.
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This is the Summary Pane

Copy Selection to Clipboard
Save Selection...

Go To...

Show Frame Size Column
Show Timestamp Column
Show Delta Celumn

Add Mew Column (Help)
Remove New Colurn
Change Column Order (Help)
Restore Default Columns

Add Bookmark...
Export...

Provide L2CAP Rules...
Provide RFCOMM Rules...

Set Subsequent Decoder Parameters...

Show Hidden Panes

Set Subsequent Decoder Parameters ===
#131. RFCOMM
Rules in effect from frame #131 onward urtil redefined here for a later frame
Onthe Slave side, with Server Channel 1, DLCI 2, RFCOMM is camying Headset (Overiddzn by user )
Change the Selected temto Cany |Headset v
OBEX
5 |
encap asyncPPP
& o) (o )
L HandsFree
—_— "

HS/HF
Undecoded RFCOMM Frames
VCP

upi
— Raw Data —

Figure 3.17 - Set Subsequent Decoder Parameters selection list

Note: If the capture has no user defined overrides, then the system displays a dialog

stating that no user defined overrides exist.
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Chapter 4 Capturing and Analyzing Data

The following sections describe the various ComProbe software functions that capture and display data
packets.

4.1 Capture Data

4.1.1 Air Sniffing: Positioning Devices

When capturing over the air packets, proper positioning of the Frontline hardware and the Devices Under
Test (DUTs) will result in the best possible captures and will mitigate sources of path loss and interference.
The following procedures will help optimize the capture process especially if you are have problems
obtaining reliable ...captures.

Problems with indoor radio propagation

Even in free space, it is well understood that radio frequencies attenuate over distance. The free-space rule-
of-thumb dictates that radio energy decreases in strength by 20 dB by each 10-to-1 increase in range. In the
real-world, the effects of objects in an outdoor environment cause reflection, diffraction, and scattering
resulting in greater signal losses. Indoors the situation can be worse. Reflections occur from walls and other
large flat surfaces. Diffraction occurs from objects with sharp edges. Scattering is produced from objects with
rough surfaces and from small objects. Also any object directly in the path of the radiation can present a hard
or soft partition depending on the partition's material properties. Path losses from partitions are difficult to
estimate.

Estimating indoor propagation loss

1
One estimate of indoor path loss, based on path loss data from a typical building, provides a Tange*s power
rule. At 2.4 GHz, the following relationship provides an approximate estimate of indoor path loss:

Indoor Path Loss (in dB) = 40 + 35Log,, (range, in meters)

This approximation is expected to have a variance of 13 dB.
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Mitigating path loss and interference

Bluetooth device design contributes to mitigating environmental effects on propagation through spread
spectrum radio design, for example. However, careful planning of the testing environment can also
contribute to reliable data capture process.

The first step to ensuring reliable air-sniffing data capture is to understand the RF characteristics of the
Devices Under Test (DUTs). The Bluetooth Class, antenna types, and radiation patterns are all important factors
that can affect the placement of the DUTs and the Frontline hardware. Radiation patterns are rarely spherical,
so understanding your device's radiation patterns can greatly enhance successful data capture. Position
devices to avoid radiation attenuation by the surroundings.

This step is optional: Consider conductive testing to establish a baseline capture. Conductive testing isolates
the DUTs and analyzer from environmental effects.

The next step is to ensure that the testing environment is as clutter-free as possible.

o Line-of-sight obstructions should be eliminated between the Frontline hardware and the DUTs because
they cause a reduction in signal strength. Obstructions include, but are not limited to: water bottles,
coffee cups, computers, computer screens, computer speakers, and books. A clear, unobstructed line-of-
sight is preferred for DUT and Frontline hardware positioning.

« If using an analyzer connected to a computer, position the computer on an adjacent table or surface away
from the analyzer and DUTs, taking advantage of the cables' length. If this is not possible, position the
computer behind the analyzer as far away as possible. If using the Frontline FTS4BT, which is a dongle,
either use an extension USB cable or position the computer such that the dongle is positioned towards the
DUTs.

o The preferred placement is positioning the DUTs and the Frontline hardware at the points of an
equilateral triangle in the same horizontal plane, i.e. placed on the same table or work surface. The sides
of the triangle should be between 1 and 2 meters for Bluetooth transmitter classes 1 and 2. The distance
for transmitter class 3 should be 1/2 meter.

Figure 4.1 - Devices Equally Spaced in the Same Horizontal Plane

Finally, eliminate other RF sources.
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o Wi-Fiinterference should be minimized or eliminated. Bluetooth shares the same 2.4 GHz frequency
bands as Wi-Fi technology. Wi-Fi interference can cause loss of packets and poor captures. In a laboratory
or testing environment do not place the DUTs and Frontline hardware in close proximity with Wi-Fi
transmitting sources such as laptops or routers. Turning off Wi-Fi on the computer running the Frontline
software is recommended.

Poor Placement

A poor test configuration for the analyzer is placing the DUTs very close to each other and the analyzer far
away. The DUTs, being in close proximity to each other, reduce their transmission power and thus make it
hard for the analyzer to hear the conversation. If the analyzer is far away from DUTs, there are chances that
the analyzer may miss those frames, which could lead to failure in decryption of the data.

Obstacles in close proximity to or in between the analyzer and the DUTs can interfere and cause reduction in
signal strength or interference. Even small objects can cause signal scattering.

Figure 4.2 - Example: Poor Capture Environment

4.1.2 Capturing Data to Disk - General Procedure

Note: Capture is not available in Viewer mode.

1. Click the Start Capture button a to begin capturing to a file. This icon is located on the Control ,
Event Display, and Frame Display windows.

2. Files are placed in My Capture Files by default and have a .cfa extension. Choose Directories from the
Options menu on the Control window to change the default file location.

Note: For the Dashboard, when you capture to series of files, the window displays
the data from the beginning of the first capture, even when a new file in the series is
created. This is because the Dashboard is a "Session Monitor", which means that
even if you capture to a series of files, the data from the first file is always
displayed. The display does not refresh when a new capture file in a series is
created.

3. Watch the status bar on the Control window to monitor how full the file is. When the file is full, it
begins to wrap, which means the oldest data will be overwritten by new data.
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4. Click the Stop Capture icon [ to temporarily stop data capture. Click the Start Capture icon again

to resume capture. Stopping capture means no data will be added to the capture file until capture is
resumed, but the previously captured data remains in the file.

5. To clear captured data, click the Clear icon iré .

o Ifyouselect Clear after selecting Stop Capture, a dialog appears asking whether you want to
save the data.
o You can click Save File and enter a file name when prompted .
o If you choose Do Not Save, all data will be cleared.
o If you choose Cancel, the dialog closes with no changes.

o Ifyou select the Clear icon while a capture is occurring:
o The capture stops.
o A dialog appears asking if you want to save the capture

o You can select Yes and save the capture or select No and close the dialog. In either case, the
existing capture file is cleared and a new capture file is started.

o If you choose Cancel, the dialog closes with no changes.

To see how to capture to a single file, choose System Settings from the Options menu on the Control window.

When live capture stops, no new packets are sniffed but there can still be packets that were previously
sniffed but not yet read by the ComProbe analyzer. This happens when packets are being sniffed faster than
the ComProbe analyzer can process them. These packets are stored either on the ComProbe hardware itself
or in afile on the PC. If there are remaining packets to be processed when live capture stops the
Transferring Packets dialog below is displayed showing the packets yet to be read by the ComProbe
analyzer. The dialog shows the name of each ComProbe hardware device, its process id in square brackets,
and the number of packets remaining. These stored packets are read until they’re exhausted or the user
clicks the Discard button on the dialog.

Unlike 802.11, Bluetooth packets never come in faster than the datasource can process them. However,
Bluetooth packets must still be stored so that they can be read in chronological order with the 802.11 packets.
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Transferring Packets ...

Current Packet Transfer Statistics:

Hardware Packets on hardware
ComProbe 502,11 [6120] 21,084
BPA S00 [2720] 3
Takal 21,087

Live capture has stopped but there are packets buffered on the ComProbe Hardware that
hawve not been decoded, These packets will continue bo be transferred and decoded until
complete,

Press the "Discard” button to stop packet transfer and discard all untransferred packets

dnsfer iz 26% complete (0 seconds remsining)

’ Discard ] [ Help

Figure 4.3 - Packet Transfer Dialog
4.1.3 Extended Inquiry Response

Extended Inquiry Response (EIR) is a tab that appears automatically on the Frame Display window
when you capture data.
[§ framepplay FISmTAe =l =
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Figure 4.4 - Frame Display Extended Inquire Response

EIR displays extensive information about the Bluetooth® devices that are discovered as data is being captured.

EIR provides more information during the inquiry procedure to allow better filtering of devices before
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connection; and sniff subrating, which reduces the power consumption in low-power mode. Before the EIR
tab was created, this type of information was not available until a connection was made to a device.
Therefore, EIR can be used to determine whether a connection can/should be made to a device prior to
making the connection.

Note: If a Bluetooth device does not support Extended Inquiry Response, the tab
displays Received Signal Strength Indication (RSSI) data, which is less extensive
than EIR data.

4.2 Protocol Stacks
4.2.1 Protocol Stack Wizard

The Protocol Stack wizard is where you define the

protocol stack you want the analyzer to use when iz e Fas =
decoding frames.
Select a protocol stack:
. Build “Your Cr -
To start the wizard: mimae
80211 Radio
Air Sniffer
1. Choose Protocol Stack from the Options BlueCore Se Pt (BCS from Cambidge Sioon Radi) wih atokaverse |2
menu on the Control window or click the Bluctoolh HCI USB wih auldiraverse
Protocol Stack icon £ on the Frame Pettious Protocol wih autotraverse
- jwt_Protocal
. LEBE
D|sp|ay_ MWS5 Wireless Coexistence Intefface 2 <
. Cument Protocol Stack: Remove Selected ftem From List
2. Select a protocol stack from the list, and LT ey 7
||ck Fi n ish Bluetooth Vitual Transport with Autotraverse
o .
Most stacks are pre-defined here. If you have i = T

special requirements and need to set up a custom
stack, see Creating and Removing a Custom Stack
on page 35.

1. If you select a custom stack (i.e. one that was defined by a user and not included with the analyzer),
the Remove Selected Item From List button becomes active.

2. Click the Remove Selected Item From Listbutton to remove the stack from the list. You cannot
remove stacks provided with the analyzer. If you remove a custom stack, you need to define it again in
order to get it back.

If you are changing the protocol stack for a capture file, you may need to reframe. See Reframing on page 36
for more information.

You cannot select a stack or change an existing one for a capture file loaded into the Capture File Viewer (the
Capture File Viewer is used only for viewing capture files and cannot capture data). Protocol Stack changes
can only be made from a live session.
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4.2.2 Creating and Removing a Custom Stack

To create a custom stack: [ Select a Protocol Stack =5=)

1. Choose Protocol Stack from the

. Select a protocol stack:
Options menu on the Control

! ) A
window or click the Protocol Stack 802.11 MAC
802.11 Radio

icon @ on the Frame Display Air Sriffer )
—_— BlueCore Serial Protocol (BCSP from Cambridge Silicon Radio) with autotraverse
Bluetooth HCI UART (H4) with autotraverse
toolbar. Bluetooth HCI USB with autotraverse
Bluetooth virtual transport with autotraverse
Fictitious Protocol with autotraverse

m

2. Select Build Your Own from the HADS with autotraverse
. . jwt_Protocal
list and click Next. LEBE

MWS Wireless Coexdstence Interface 2 Sk

3. The system displays an information

screen that may help you decide if Curent Protoco Stackc p—
you need to define your own l

custom stack. Defining a custom

stack means that the analyzer uses g Ned> ] [ Concel

the stack for every frame. Frames
that do not conform to the stack
are decoded incorrectly. Click Select a Protocol Stack L

Next to continue.
Choose one at a time by Protocol Decode Stack:
double clicking or by using All additional stack layers | Baseband
s | t P t | [eez Failiiinm: @) can be determined AVDTP
eleC rotocols AMP Manager o automatically.
ARP —. There are no additional
1. Selecta protocol from the list on e ] stack layers.
AVDTP >
the eft
AVDTP Recover
2. Click the right arrow button to ggg gi';ﬁgﬁng
move it to the Protocol Decode AVRCR
. rowsing
Stack box on the right, or double- Baseband Vove Down
. . BCCMD
click the protocol to move it to the BIP —
right BlueCore Serial Protocal ™
. 4 [m 3
3. Toremove a protocol from the
stack, double-click it or select it [ <Back | Fnsh | [ Cancel |

and click the left arrow button.

4. If you need to change the order of the protocols in the stack, select the protocol you want to move,
and click on the Move Up and Move Down buttons until the protocol is in the correct position.

5. The lowest layer protocol is at the top of the list, with higher layer protocols listed underneath.
Auto-traversal (Have the analyzer Determine Higher Layers)

If you need to define just a few layers of the protocol stack, and the remaining layers can be determined
based on the lower layers:

1. Click the All additional stack layers can be determined automatically button.

2. If your protocol stack is complete and there are no additional layers, click the There are no
additional stack layers button.

3. If you select this option, the analyzer uses the stack you defined for every frame. Frames that do use
this stack are decoded incorrectly.
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Save the Stack

1. Click the Add To Predefined List button.

2. Give the stack a name, and click Add.
In the future, the stack appears in the Protocol Stack List on the first screen of the Protocol Stack wizard.
Remove a Stack

1. Selectitin the first screen and click Remove Selected Item From List.

2. If you remove the stack, you must to recreate it if you need to use it again.

Note: If you do not save your custom stack, it does appear in the predefined list, but
applies to the frames in the current session. However, it is discarded at the end of the
session.

4.2.3 Reframing

If you need to change the protocol stack used to interpret a capture file and the framing is different in the
new stack, you need to reframe in order for the protocol decode to be correct. You can also use Reframe to
frame unframed data. The original capture file is not altered during this process.

Note: You cannot reframe from the Capture File Viewer .

To reframe your data, load your capture file, select a protocol stack, and then select Reframe from the File
menu on the Control window. Reframe is only available if the frame recognizer used to capture the data is
different from the current frame recognizer.

In addition to choosing to Reframe, you can also be prompted to Reframe by the Protocol Stack Wizard.

1. Load your capture file by choosing Open from the File menu on the Control window, and select the
file to load.

2. Select the protocol stack by choosing Protocol Stack from the Options menu on the Control
window, select the desired stack and click Finish.

3. If you selected a protocol stack that includes a frame recognizer different from the one used to
capture your data, the Protocol Stack Wizard asks you if you want to reframe your data. Choose
Yes.

4. The analyzer adds frame markers to your data, puts the framed data into a new file, and opens the
new file. The original capture file is not altered.

See Unframing on page 36 for instructions on removing framing from data.

4.2.4 Unframing

This function removes start-of-frame and end-of-frame markers from your data. The original capture file is
not altered during this process. You cannot unframe from the Capture File Viewer (accessed by selecting
Capture File Viewer or Load Capture File to start the software and used only for viewing capture files).
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To manually unframe your data:

1. Select Unframe from the File menu on the Control window. Unframe is only available if a
protocol stack was used to capture the data and there is currently no protocol stack selected.

In addition to choosing to Unframe, you can also be prompted to Unframe by the Protocol Stack Wizard.
1. Load your capture file by choosing Open from the File menu on the Control window.
2. Select the file to load.
3. Choose Protocol Stack from the Options menu on the Control window
4. Select None from the list

5. Click Finish. The Protocol Stack Wizard asks you if you want to unframe your data and put itinto a
new file.

6. Choose Yes.

The system removes the frame markers from your data, puts the unframed data into a new file, and opens
the new file. The original capture file is not altered.

See Reframing on page 36 for instructions on framing unframed data.

4.2.5 How the Analyzer Auto-traverses the Protocol Stack

In the course of doing service discovery, devices ask for and receive a Protocol Descriptor List d